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File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Apply an Animation Scheme
	11-1
	Choose Slide Show, Animation Schemes. Select a scheme from the list of animation schemes. Click Apply to All Slides.
	Motion1.ppt
	None

	Apply Custom Animation
	11-2
	Choose Slide Show, Custom Animation. Select the object. Click Add Effect at the top of the Custom Animation task pane. Choose an effect type.
	None
	None

	Apply Emphasis and Exit Animation Effects
	11-3
	Select the object, click Add Effect on the Custom Animation task pane, and point to Emphasis. Select an emphasis effect.

Select the object, click Add Effect on the Custom Animation task pane and point to Exit. Choose an exit effect from the categories.
	None
	None

	Apply a Motion Path to an Object
	11-4
	Select the object, click Add Effect on the Custom Animation task pane and point to Motion Paths. Choose More Motion Paths. Select options from the Add Motion Path dialog box.
	None
	Sol-11-3.ppt

	Remove Animations
	11-5
	Select the object in the Custom Animation list. Click Remove at the top of the Custom Animation task pane or press [Delete].
	None
	None

	Modify Animations
	11-6
	To make the animation appear automatically, select the object or text. Click the Start list box drop-down arrow in the Custom Animation task pane and choose After Previous. If required, click the Speed list box drop-down arrow and choose the speed setting.
	None
	Sol-11-6.ppt

	Add Sound Effects to Animations
	11-7
	Select an item listed in the Custom Animation task pane. Choose Effect Options from the list box options. Click the Sound list box and select the desired sound effect.
	None
	None

	Modify the Order of Animations
	11-8
	On the slide master, select the body placeholder, and apply an animation effect. In Normal View, click the Master: Body list box arrow in the custom animation list, and choose Copy Effects to Slide. Select individual objects and apply animation effects to them. In the Start drop-down list, choose With Previous.
	None
	Sol-11-8.ppt

	Modify an Animation’s Timing
	11-9
	Select an item in the custom animation list. Click its list box arrow. Choose Timing. In the Delay spin box, key or select the timing in seconds.
	None
	Sol-11-9.ppt

	Copy an Animated Object
	11-10
	Select the animated object on the slide, copy it to the clipboard, and then paste it on the same slide or on a new slide.
	None
	Sol-11-10.ppt

	Insert Sound Clips
	11-11
	Choose Insert, Movies and Sounds, Sound from Clip Organizer.
	None
	None

	Control How Music and Sound Plays
	11-12
	Click the sound item’s list box arrow and choose Effect Options. Click the Effect tab on the Play Sound dialog box. Choose from the given options.
	
	Sol-11-14pt

	Play Music from a CD
	11-13
	Choose Insert, Movies and Sounds, Play CD Audio Track.
	None
	None

	Insert and Play a Movie
	11-14
	Choose Insert, Movies and Sounds, Movie from Clip Organizer.
	None
	None

	Use Rehearse Timings to Set Automatic Slide Timings
	11-15
	Choose Slide Show, Rehearse Timings.
	None
	None

	Set Timings Manually
	11-16
	Choose Slide Show, Slide Transition. Under the Advance Slide section, select the Automatically after check box, and then manually enter the time interval in seconds.
	None
	None

	Set Up a Slide Show
	11-17
	Choose Slide Show, Set Up Show. Select from the options on the Set UP Show dialog box.
	None
	Sol-11-17.ppt

	Create and Run Custom Shows
	11-18
	Choose Slide Show, Custom Shows.
	None
	Sol-11-18.ppt

	Create Action Button Links to Custom Shows
	11-19
	Choose Slide Show, Action Buttons.
	None
	Sol-11-19.ppt

	Create a Summary Slide with Text Hyperlinks
	11-20
	Switch to Slide Sorter view and select the slides. Click the Summary Slide button on the Slide Sorter toolbar. Select the text or the bullet of a summary point. Right-click and choose Hyperlink, or press [Ctrl]+[K]. In the Insert Hyperlink dialog box under Link to, choose Place in this Document. Select the link slide.
	None
	None

	Create Links that Return to the Menu Slide
	11-21
	Choose Slide Show, Action Buttons. In the Action Settings dialog box, click the Hyperlink to list box arrow and choose Slide.
	None
	Sol-11-21.ppt

	Add entrance, emphasis, and exit animation effects; add a sound effect; and change timing.
	11-22
	
	Promo1.ppt
	Sol-11-22.ppt

	Copy an animated object, add animation effects to a master slide, override master slide animations on a slide, and add music.
	11-23
	
	Bevgs1.ppt
	Sol-11-23.ppt

	Change animation settings, set slide timings, use Set Up Show options, create custom shows, and create action buttons and hyperlinks.
	11-24
	
	Employ1.ppt
	Sol-11-24.ppt

	Create text animations, object animations, add a movie and music, and add action buttons.
	11-25
	
	SpEvent3.ppt
	Sol-11-25.ppt

	Animate text and objects, override master slide animations, and set up the slide show.
	11-26
	
	Comp1.ppt
	Sol-11-26.ppt

	Apply entrance, emphasis, and exit effects to objects; animate text; create a summary slide with hyperlinks; and insert an action button.
	11-27
	
	Stratgy2.ppt
	Sol-11-27.ppt

	
	11-28
	
	None
	None

	
	11-29
	
	None
	None

	
	11-30
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures

· PowerPoint slides

Lesson Outline

Section 11.1

Using Animation Schemes and Custom Animation

This section focuses on:

· Applying an Animation Scheme

· Applying Custom Animation

· Applying Emphasis and Exit Animation Effects

· Applying a Motion Path to an Object

· Removing Animations

Section 11.2

Modifying and Enhancing Animation Effects

This section focuses on:

· Modifying Animations

· Adding Sound Effects to Animations

· Modifying the Order of Animations

· Modifying an Animation’s Timing

· Copying an Animated Object

Section 11.3

Adding Multimedia Elements
This section focuses on:

· Inserting Sound Clips

· Controlling How Music and Sound Plays

· Playing Music from a CD

· Inserting and Playing a Movie

Section 11.4

Controlling a Slide Show

This section focuses on:

· Using Rehearse Timings to Set Automatic Slide Timings

· Setting Timings Manually

· Setting Up a Slide Show

Section 11.5

Working with Custom Shows

This section focuses on:

· Creating and Running Custom Shows

· Creating Action Button Links to Custom Shows

· Creating a Summary Slide with Text Hyperlinks

· Creating Links that Return to the Menu Slide

	Lecture Outline
	Lecture Notes

	Animation and Slide Show Effects

PowerPoint enables users to control movement of objects on the slides using:

· Animation schemes—Offer a quick and easy way to add interest to a presentation by animating text and adding other special effects, including transitions.

· Custom animation tools—Enable users to create other types of text animation and to animate objects such as clip art, drawings, and video clips. Custom animation enables users to control the timing, speed, sound, and other aspects of how and when the elements of a slide appear on the screen.

Section 11.1

Using Animation Schemes and Custom Animation

Users can animate an object, text, or graphics by applying visual and sound effects that control how the object behaves during a slide show. For example, users can make an object:
· Fly into the center of the screen accompanied by a sound effect.
· Fade into the background when another object appears.
· Blink when users click their mouse button.
· Leave the screen in a spiral path.

Users can select from preset Animation Schemes in the Slide Design task pane. These Animation Schemes control placeholder movement and slide transitions. The Custom Animation task pane provides many tools that enable users to create a variety of interesting effects.

Applying an Animation Scheme

Animation schemes are displayed in the Slide Design task pane. The task pane’s list box displays a list of recently used schemes, followed by subtle schemes, moderate schemes, and exciting schemes. A chosen animation scheme is applied to all the slides that are selected at that time.

Applying Custom Animation

An object can be animated using the Custom Animation task pane. There are two ways to display the Custom Animation task pane:

· Choosing Custom Animation from the Slide Show menu.
· If a task pane is already displayed, clicking the Other Task Panes arrow on the task pane title bar and choosing Custom Animation from the drop-down list.
There are four types of effects that users can apply:

· Entrance—Is applied to text or an object to control how it first appears on a slide.

· Emphasis—Is applied to draw attention to an object that is already displayed on a slide.

· Exit—Is applied to control how an object leaves, or disappears from, a slide.

· Motion Paths—Is applied to define the line of travel that an object can follow as part of an animation effect.

After an effect is applied, an animation tag, which is a small, numbered box, appears on the slide next to the animated object. The number in the box indicates the order in which the animation will play in relation to the other animation effects on the slide. This number correlates with the list of animations in the custom animation list.
The custom animation list:

· Is a list of all animations applied to the current slide.
· Appears on the Custom Animation task pane.

· Can be reordered.

Applying Emphasis and Exit Animation Effects

Interesting emphasis effects can be used to draw the audience’s attention to an object on the slide. Similarly, exit effects can be applied to objects when they leave or disappear from a slide. Users can combine these effects.
Applying a Motion Path to an Object

Motion paths enable users to make an object enter a slide from any point and travel across the slide in a variety of paths, including diagonal, zigzag, or spiral paths. Users can add motion paths to any object, including text.

Users can apply a motion path by selecting the object, clicking Add Effect on the Custom Animation task pane, and pointing to Motion Paths.
Removing Animations
An animation can be removed from an object by selecting it in the custom animation list, and clicking Remove at the top of the Custom Animation task pane or pressing [Delete].
	Lesson Key Objective

Explain how to add animation and slide show effects to a PowerPoint presentation.
Teaching Tip:

Explain to students that they should use animation carefully to enhance, and not distract from, the message that their presentation needs to deliver.

[image: image1.emf]Apply an Animation  Scheme

 
[image: image2.emf]Apply an Animation  Scheme


Text Figure: F11-01

Additional Notes:

If the task pane is already open, you can also display the Slide Design task pane by clicking the Other Task Panes button on the task pane title bar and choosing Slide Design – Animation Schemes from the drop-down list.

Additional Notes:

Slide transitions are the effects between two slides during a slide show. Transitions can be applied to one or more slides using the Slide Transition task pane or in Slide Sorter view.
Text Figures: F11-02, F11-03

[image: image3.emf]Apply Custom  Animation


Additional Notes:

You can select the animation effect you want from the drop-down list. Choose More Effects only when the effect you want is not in the list.


[image: image4.emf]Apply a Motion Path  to an Object


Teaching Tip:

If your students are familiar with using PowerPoint’s freeform drawing tools, they can use those tools to create custom motion paths.

Text Figures: F11-04, F11-05, F11-06



	Section 11.2

Modifying and Enhancing Animations

Users can modify and enhance animation effects by making them appear faster or slower, dissolve or fly, and by attaching sound effects. Animation effects can be activated by a mouse click or played automatically.
Modifying Animations

Animations can be modified so that they appear automatically or can be activated by a mouse click. Users can also change the speed at which the animation occurs.

Adding Sound Effects to Animations

Users can add sound effects as part of an object animation or as an object by itself. Users can add sound using:

· The Custom Animation task pane.

· The Clip Art task pane.
If users add sound using the Custom Animation task pane, the sound becomes a part of an animation effect.

Modifying the Order of Animations

When animating a body text placeholder, users can control the order in which the text appears:

· All at once so text appears as one object

· All paragraphs (or bullet) at the same time

· Paragraphs (or bullet) entering by their level

To apply a consistent movement effect to all the bulleted lists in a presentation, the animation should be applied on the slide master.
To make an animation appear at the same time as another animation, reposition its listing in the custom animation list so that it is directly below the other animation, and change its Start setting to With Previous.

Modifying an Animation’s Timing

Users can fine-tune the timing of an animation by specifying a delay before the animation begins.

Copying an Animated Object

Users can save time and effort by copying an animated object from one slide to another, rather than creating a new object. The animations are copied along with the object.
	Teaching Tip:

Point out the time line that appears in the custom animation list when students click the Play button at the bottom of the Custom Animation task pane.

Teaching Tip:

Remind students that choosing After Previous for the first list item even though there is no previous item in the list causes the animation sequence to start as soon as the slide displays.
Additional Notes:

When list items are moved to a different position, timing and start settings sometimes need to be changed. Experimentation is often the only way to determine the best settings for the effect you want.

[image: image5.emf]Add Sound Effects to  Animations


Text Figure: F11-07
Additional Notes:

If you have trouble adjusting the volume, click the speaker icon on the right side of the Windows task bar to adjust your system’s sound.


[image: image6.emf]Modify the Order of  Animationss


Text Figures: F11-08, F11-09
Teaching Tip:

Point out that the Spin dialog box enables students to change some of the options that appear on the Custom Animation task pane, for example, the Start and Speed options. Also inform them about the Repeat button, which is used to repeat an effect more than one time.
Text Figure: F11-10


	Section 11.3

Adding Multimedia Elements

Users can insert multimedia elements like sound and movie clips into a presentation.

Sound files:

· Users can attach sound effects to animations, as well as add stand-alone sound objects.

· Sound objects can be set to play automatically when a slide appears or on a mouse click.
· Sound files from the Clip Organizer usually have a .wav or .midi extension.
Movie clips:

· In PowerPoint, the term movie refers to any motion file, for example, a video clip or an animated clip art file.

· Animated files are also known as animated GIFs.

Microsoft provides many animated files and sound files within Office 2003 Professional.

Inserting Sound Clips

Users can add a short sound clip to accompany an animation effect, or they can set music to play for an entire slide or an entire presentation. Choosing Movies and Sounds from the Insert menu enables users to add sound clips.
Controlling Music and Sound Plays

Users can change a music object so that it plays automatically when a slide starts, or on a mouse click, or after another animation. This can be done using the Custom Animation task pane. If the music object is set such that it does not need a mouse click to start, it can be hidden by dragging it off the slide onto the gray desktop area of the Slide pane.
Playing Music from a CD

Users can prepare professional presentations by playing music from a CD. Inserting a music CD track is similar to inserting a .wav or .midi file. Users can play music from a CD by choosing Movies and Sounds from the Insert menu, and choosing Play CD Audio Track from the submenu.

Inserting and Playing a Movie

Inserting a movie (or animated clip art file) onto a slide is similar to inserting a sound object. Users can add animation effects to a movie clip to control when and how it appears.


	
[image: image7.emf]Insert Sound Clips


Text Figure: F11-11
Teaching Tip:

Exercise 11-11 assumes that the Office 2003 media content has been installed on student’s computers. If this is not the case, students might not be able to execute steps 1 through 7. Step 8 instructs students to copy a sound object from slide 7 to slide 1 if they cannot locate a suitable music file.
Text Figures: F11-12, F11-13, F11-14
Teaching Tip:

The custom animation list may or may not show a sound item. If there is a sound item, students are asked to delete it by using Figure 11-12 as a guide. 

Additional Notes:

To make a sound play for the duration of an entire presentation, right-click the sound object and choose Edit Sound Object from the shortcut menu. In the Sound Options dialog box, check the box labeled Loop until stopped and click OK.
Teaching Tip:

Explain to students that getting the timing right can sometimes be tricky and requires experimentation and experience.

[image: image8.emf]Play Music from a CD


Text Figure: F11-15
Additional Notes:

Most animated movies become distorted when their size is increased, so be careful when you are trying to make these images larger.

	Section 11.4
Controlling a Slide Show
Users can create a self-running slide show by setting slide timings such that the animation and slides can advance automatically.

Using Rehearse Timings to Set Automatic Slide Timings
The Rehearse Timings command offers a convenient way to set slide timings. When users start the Rehearse Timings procedure, the slide show begins with the Rehearsal toolbar displayed. The Rehearsal toolbar buttons can be used to advance animations and slides, to pause, or to repeat a slide. The Rehearse Timings command is located on the Slide Show menu.
The time it takes to advance from one animation or one slide to another is automatically recorded. These times are used when the slide show is set to run automatically.

Setting Timings Manually

Users can set slide timings manually. They need to estimate the time interval between each item. This can be achieved by:
· Clicking the Slide Show menu and choosing Slide Transition.

· Selecting the Automatically after check box under the Advance Slide section in the Slide Transition task pane, and manually entering the timing in seconds.

Setting Up a Slide Show

PowerPoint provides users with tools to fine-tune the way they run a show. Users can:

· Run a show in a window or using the full screen.
· Advance slides using the mouse and keyboard or have slides advance automatically using preset slide timings.
· Run a show with or without preset animations.
· Run a show with or without prerecorded voice narration.
The Set Up Show command on the Slide Show menu provides users with options to customize their show.
	Text Figure: F11-16
Teaching Tip:

If proper sound equipment and microphones are set up in the lab, students could record a narration along with rehearsing timings. Inform students that they will be recording a narration as part of setting up a Web broadcast in Lesson 15.

[image: image9.emf]Use Rehearse  Timings to Set Automatic Slide Timings


Teaching Tip:

Explain to students the purpose of the Rehearsal toolbar buttons with the help of Table 11-1.

Teaching Tip:

If slides and animations do not advance automatically, check the Set Up Show dialog box (Slide Show, Set Up Show). In the Advance Slides section, make sure that Using Timings, if present is checked. 

[image: image10.emf]Set Timings Manually


Teaching Tip:

Encourage students to experiment with other options in the Set Up Show dialog box. Also, have them click the Help button on the dialog box’s title bar and then click an option to find more about it.

	Section 11.5
Working with Custom Shows
A custom show:

· Is a presentation within a presentation.
· Displays only specially selected slides instead of all the slides in a show.
· Is convenient if users have a large presentation that deals with several different topics.
Creating and Running Custom Shows

Users can create a custom show by selecting related slides within a presentation and giving the selected group a name. Users can create and run custom shows using the Custom Shows dialog box, which can be accessed from the Slide Show menu.
Creating Action Button Links to Custom Shows

Users can create an action button to set up custom shows without interrupting the presentation. An action button is a button with a link associated with it, or a hyperlink that users can click to discreetly choose the show that is right for their audience.

Creating a Summary Slide with Text Hyperlinks

A Summary slide:

· Is a slide that contains the titles of some or all slides in a presentation.

· Can be used as an agenda slide or a table-of-contents slide.

· Can be used as a wrap-up slide at the end of a presentation.

· Can have hyperlinks to other slides, custom shows, other presentations, or files created by other programs.

· Can be created in Normal view, though it is usually more convenient to use Slide Sorter view.
Creating Links that Return to the Menu Slide

Setting up links on a summary slide enables users to jump to different slides in a presentation. Creating links that return to the menu slide require that an action button or hyperlink be created on each slide to which users set up a link. When users insert an action button or hyperlink on the slide master, it appears on every slide (except the title slide) in the presentation.
	
[image: image11.emf]Create and Run  Custom Shows


Text Figures: F11-17, F11-18


[image: image12.emf]Create a Summary  Slide with Text Hyperlinks


Teaching Tip:

Ask students to edit their custom shows before creating the action buttons. If a hyperlink is linked to a custom show that starts on the same slide as the one on which the hyperlink or action button is placed, there can be a conflict that prevents the show from running properly.

Teaching Tip:

Explain to students that they can select any or all slides to include in a summary slide. The summary slide is always inserted before the first slide that was selected, but it can be moved to any position in the slide show.

[image: image13.emf]Create Links that  Return to the Menu Slide


Additional Notes:

When creating hyperlinks for a menu slide, ensure that the slide to which you link matches the text in the text box at the top of the Insert Hyperlink dialog box.

Text Figures: F11-19
Additional Notes:

Usually you do not use automatic slide timings when using a summary slide with hyperlinks.




















































































































PAGE  

_1149411947.unknown

_1149412205.unknown

_1149412270.unknown

_1149412339.unknown

_1149412379.unknown

_1149412301.unknown

_1149412240.unknown

_1149412129.unknown

_1149412165.unknown

_1149411984.unknown

_1149411872.unknown

_1149411914.unknown

_1149411864.unknown

